ANALISE DE UMA ESCADA HELICOIDAL USANDO O ABAQUS 6.12
STUDENT EDITION
1. INTRODUCAO

1.1.DESCRICAO DO PROBLEMA

Apresenta-se a seguir o esquema de uma escada helicoidal em balancgo
que serd analisada utilizando-se o programa ABAQUS.
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Figura 1. Esquema da escada em balanco.

1.2. PROPRIEDADES DO MATERIAL

Mdédulo de Elasticidade Longitudinal ou de Young: E = 1.5E6 tf/mz;
Coeficiente de Poisson = 0.2

1.3.PROPRIEDADES GEOMETRICAS

Espessura da Laje: 0.35 m.



O bordo CD esta 1.90 m acima do bordo AB.
1.4.CARGA
Carregamento distribuido de 1.275E6 tf/m?2
2. RESOLUCAO
O procedimento de resolucdo pode ser demonstrado no seguinte

fluxograma (a ordem pode eventualmente ser quebrada em pontos especificos

por conveniéncia):



PRE-PROCESSAMENTO

Inicio da Analise

Criagdo da geometria base (Parts)

Definir Tipo de Elementos

Atribuicdo das propriedades das
sec¢oes das barras (Sections)

Atribuicdo das propriedades dos
materiais (Materials)

Associa¢do das SecOes, geometria
base, materiais... (Section
Assignments) (Assembly)

Aplicar¢ao das condigoes de
contorno

Apoios (BCs)

Cargas (Loads)

Criagdo da geometria da malha
(Mesh)

Elementos calculaveis pelo
método dos elementos finitos.
Aproximagdo da estrutura real.

_IDefinigﬁo das Variaveis de Sal'daI

(Field Output Requests)

PROCESSAMENTO

Solugdo, Calculos
Computacionais (Jobs)

POS-PROCESSAMENTO

Andlise dos resultados

Variavéis de saida

Analise grafica




2.1.INICIO DA ANALISE

v' Se vocé ainda nao iniciou o programa Abaqus/CAE, cmd no
Menu Iniciar para abrir o Prompt de Comando e nele
abg6122se cae para executar o Abaqus.

v" Em Create Model Database na caixa Start Session que aparece,

With Standard/Explicit Model.

2.2.PRE-PROCESSAMENTO

v No menu Model a esquerda, com o botdo direito em Model-1 e
Rename. EscadaHelicoidal.
v No menu Model a esquerda, dé duplo clique em Parts, no campo Name

Patamar, e as opgoes: 3D, Deformable, Shell, Planar.

Em Approximate size 20 e em Continue...
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v' Em seguida, em Create Lines: Rectangle (4 Lines) e as

coordenadas 1.5,0 — 3.5,-2. a funcéo e em Done.
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v No menu Model a esquerda, dé duplo cligue em Parts (1), no campo
Name digite Escada, e selecione as opgodes: 3D, Deformable, Shell,

Revolution. Cligue em Continue...
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v. Em seguida, Clique em Create Lines: Connected e Insira as
coordenadas 1.5,0 — 3.5,0. Desative a fungdo e cligue em Done. Na
janela Edit Revolution, digite 180 em Angle, marque Include
translation, pitch: e digite 1.9. Clique em OK.
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v" No menu Model a esquerda, d& duplo cligue em Materials. Na janela
Edit Material selecione Mechanical>Elasticity>Elastic e digite 1.5E10
em Young’s Modulus e 0.2 em Poisson’s Ratio. Clique em OK.
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[ A nev model databose has been created
| b Tne Redel ode 17 ez b creatad

=

v No menu Model a esquerda, dé duplo cligue em Sections. No campo
Name: digite SecdoShell, em Category selecione Shell, e em Type

selecione Homogeneous. Clique em Continue...
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v' Na janela

been crested
baz been crested

Edit

Section,

Certifique-se de que Material-1 esta

selecionado em Material, digite 0.35 no campo Shell thickness>

Value: e clique em OK.
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[ A nev nodel databoze has
| bed e Rodel Model-1 ha!

z}

been creat,

od
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v" Na caixa de ferramentas clique em Assign Section. Selecione a parte

Escada e clique em Done. Selecione SecaoShell e cligue em OK.
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v" Na barra de Ferramentas, selecione Part:>Patamar e dé Assign

Section nessa parte também.
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v" No menu Model a esquerda, abra Assembly, dé duplo cligue em
Instances, selecione Escada e Patamar em Parts e cligue em Apply...
Selecione Patamar novamente, margque Auto-offset from other

instances e cligue em OK na janela Create Instance.
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i now notal databass has becs crested
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v' Utlizando as ferramentas Translate Instance e Rotate Instance

reposicione as partes Patamar conforme a imagem a seguir.
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4 e wosal datebare bas boen crosted
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| The instance Patanar-l vas rotated by 90, desress sbot the sxiz defined by the peint 1§ 2nd'the vectar 2

v" Na caixa de ferramentas clique em Merge/Cut Instances. No Campo
Part Name digite EscadaCompleta. Em Geometry>Intersecting
Boundaries, marque Retain e clique em Continue... Selecione tudo e

cligue em Done.
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v" No menu model a esquerda, dé duplo cliqgue em Steps (1). Digite
Carregamento no campo Name: e cligue em Continue... Entdo cligue

em OK na nova janela que se abre.
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v" No menu model a esquerda, de duplo clique em Loads. Na janela
Create Load, no campo Name digite CargaDistribuida, em Types for
Selected Step selecione Pressure e clique em Continue.... Selecione

toda a escada e cligue em Done.
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to the sssembly coordinats systea

v" No caso todas as faces superiores devem ser da mesma cor. Clique em

Flip a surface e clique na face Marrom. Selecione entdo a opgao

Purple. Na janela Edit Load, digite 1.275E4 no campo Magnitude: e
cligue em OK.
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[ |Tenodel Kodai-1 hes bmea created

| 2 Te foetance Fatansr-? was treneisted by -7.201. L.0S. 0. vith resect to the sssenbly coordinate sve

@ The instance Patomar-2 was roteted by -90. desrees t the axis defined the point -3, s 350 E—us 0. end ()w ue\:mx 2 .0
The inciance Fatemso—L was roteiad by 00, dessems sbest the sxis defioed by the soumt 1.4 ine vaciar

v’ Selecione as arestas dos Patamares opostas a escada e clique em
Done. Marque ENCASTRE (U1 =U2 =U3 =UR1 =UR2 =UR3 =0) na

janela Edit Boundary Condition e clique em OK.
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By 30 degzens atoas the sxis deiined by the point 18 0 0 and the veotor 2. 0

v" Na barra de contexto, em Module, selecione Mesh, e em Object,
selecione Part:>EscadaCompleta. Na barra do menu principal, clique
em Mesh>Element Type e selecione com o mouse toda a escada.
Cligue em Done. Abrird a janela Element Type. Em Family, selecione

Shell e em Geometric Order, selecione Quadratic. Cligue em OK.
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i nev ot datebare bas teen crosied
& Te nodel el cres:
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2| The iostance Patensr-i was rotated by 30 dsrese atouk in akte.dat aed by’ thm wosat 18 and the vector 2

v" Na barra do menu principal, cligue em Seed>Part, altere Approximate

global size: para 0.5 e cligue em OK.
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v' Na barra do menu principal, clioue em Mesh>Part. Aparecera a
pergunta “OK to mesh the part?”, clique em Yes. Perceba que a
estrutura fica na cor azul.
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v No menu model a esquerda, abra Field Output Requests (1) e dé
duplo-clique em F-Output-1. Abra Forces/Reactions, marque SF,
Section forces and moments e clique em OK.
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Timing: Qutpus at exact bmes

Output Vacibles

® Seectfrom st below ) Preseected defaults ©) All

8 | SPEPEEQPEMAG LE.U,RF,CF,5F,CSTRESS COISP.

Ay e
b W s
P W Displocement Velocity Accelerstion
v M Forces/Resctions
£ FF. Reaction forces and moments
R, Reaction forces
PAL Reaction moments
11 CF, Concentrated forces and moments
1 SF, Section forces and moments
TF, Tetsi orces snd moments

e

VE, Viscous forces snd moments due to staic stabiization

o T T Acsombydefacs v/~

Edit variables

RBFOR Force  rebar
B, Body forces
'CORIOMAG, Magritude of Coricés loads

(GRAY, Unsformly distributed gravity fouds
P, Pressure loads.

Note:

NFORC. Nod forces due to clement stresses
NFORCSO, Nodl forces in beam section orientation

ROTAMAG, Magritude of rotary acceleration loads
(CENTMAG, Magnitude of centréugal losds (tho times cmega squared)
CENTRIFMAG, Magnitude of centrfugal loeds (omega squared)

Output fee rebar

Output ot shell bean, 4 lyered section points:
 Usedefasts © Specty

¥ Inctude local coordaate deections when saiatle

[0k

=g %
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30 degrees stoat the

n gemerated on part. EscedaCompleta

2.3.PROCESSAMENTO

v" No menu model a

o the sssenbly coordinste systea
axis defined by the point —3.5
"1 vax rotatad by 30 desrass sbout the axis defined by the point 1.8, 0

350 B0, 0. end the vector 2.. 0. 0
the vector 2. 0.. 0

esquerda, d¢ duplo cliqgue em Jobs. Na janela Create

Job, apenas clique em Continue... Na janela Edit Job, cligue em OK.

v’ Abra Jobs(l) e cligue com o botdo direito em Job-1. Cligue em

Submit. Se aparecer uma janela dizendo “Job files already exist for Job-

1. OK to overwrite?”, clique OK. Aguarde o processamento dos dados.

Estara concluido quando aparecer “(Completed)” ao lado de Job-1 no

menu model a esquerda.

RPN
[8) Fie Model Viewpot Yiew lcb Adsptiviy Co-eecution Qptimization Jock

LEESEE FHIO +C UL EA M

Mode | Resuts
5 Model Database s
[—
@ [y Parts )
4Bz Matenals 1)
© Coliatons
% Sections (1)
o poties
16 Aszembly
@ Instances (1)
I Position Constraints

58 Fesures 1)
oy Sets )
4 Sutaces 1)
B Connector Asignment:
54 Engineeing Festures
08 Steps @)
= Fied Outpus Requests (1)
5 F-Output1
B Hisory Outpus Requests 1)
£ Tene Pois
fie ALE Adaptive Mesh Constraints |
T Intwactions
B Interacion Properties
B Contact Controls
i Contact ntiliations
1# ContactSabiations
4] Constrants
8 Cornectr Sections
5 F Fieds
P ampiitudes
0 Loads 1)
)
& Predefned Fieds
D Remeshing Rules
B Suiech Contea CuleSpace

hronsisted by 7201, 1,05 0. w

b o

ated an part. EscadsConplete

i
b
| T . ith respect
Th rotated by —30 dearees shout the
I R FOLS1ed by 30, degrens sbout the axis deiiosd by the point
36 =
Th Bpon » Freated

gt N0 D@
. 3
oot Fw ] Mot [tcduieods ] stem [ Corpareris T
Jqam
T @
M=
um

&
1)
Q

x
75 simuLin

to the sssembly coordinate systea
2xis defined by the point -1.5

the vector 2.. 0. 0
the vector 2. 0

D ED 0. et
and



2.4.POS-PROCESSAMENTO

v" No menu model a esquerda, clique com o botdo direito em Job-
1(Completed)>Results. A tela de analise de dados se abrira. Na caixa
de ferramentas, clique em Plot Contours on Deformed Shape.

v Na barra de ferramentas no canto superior a direita, seclecione U>
Magnitude. Na barra de menus principal, cligue em
Viewport>Viewport Annotation Options... Na janela aberta, sclecione

a aba Legend. Clique em Set Font. Na nova janela, altere Size para

14. Cligue OK nas duas janelas abertas.
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v" Na barra de ferramentas no canto superior a direita, selecione também
SM> SM1, SM> SM2 e SM> SM3.
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inp' has been submitted for analysiz

Filo Processor conplated succesatully C|

s Standard coapleted successiully =
e 1

v" Na barra de menu principal, cligue em Report>Field Output. Na janela
Report Field Output, cligue em SM: Section Moments e clique em
Apply. A mensagem aparecera: “The field output report was appended

to file “abaqus.rpt”.” O arquivo abaqus.rpt pode ser encontrado em

C:\Users\"Nome do Usuario”\abaqus.rpt.
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) AC YELD: Actve yiekd flag

P 71 Stain components

P 719E Plstic stran companents
PEEQ: Equualent plasti st
PEMAG: Magitude of plastc tran

P 135 Stess components

P 71 5F:Section Forces

P 715M: Section Moments
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| G2 ]| sectonpomt:
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abaqus.rpt - Nc&_@lﬂu

| Eile Edit Format View Help
| R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R W -~
Field output Report, written Fri Dec 06 22:06:55 2013
Source 1
ODB: C:/Users/GustavoN,/Job-1.odb
Step: Carregamento
Frame: Increment 1: Step Time = 1.000
Loc 1 : Integration point values from source 1
output sorted by column "Element Label™.
Field output reported at integration points for region: ESCADACOMPLETA-1.Region_1
Element Int SM. 5M2 SM. M1 sM. 5M3
Label Pt @Loc 1 @Loc 1 @Loc 1
M1 nimum -169. 045403 -32.0439e+03 -9.77166E4+03
AT Element 3z 31 32
Int Pt 3 4 4
Max1mum 56.1086 13.0803E+03 17.5481E+03
AT Element 73 64 25
Int Pt 1 4 4
Total -8.35971E406 1.42511E+06 628.417E4+03
Field output reported at integration points for region: ESCADACOMPLETA-1.Region_2
Element Int 5M. 5M2 SM. SM1 SM. SM3
Label PL @Loc 1 @Loc 1 @Loc 1
M ni mum 18, 3427E+03 -3. 3007 3E+03 -17.5481E+03
AT Element 13 13 B
Int PT 3 4 1
Maximum 169. 045403 32.0439E+03 9.77166E+03
At Element 1 2 1
Int PT 2 1 1
Total 5.79464E4+06 527.090e+03 -628.417E403 D

4



v Em Output Variables>Position: altere para Unique Nodal.

Desmargue as variaveis anteriores e marque U: Spatial displacement.
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N P 71 O Pomt moments
P € Stain components
~ P 1719 Pustic st companents
[ PEEQ: Equialent lastic stron
7] PEMAG: Magnitude of plastic strsin
K@ P I RF: Reaction force
&am P 71 RM Reaction moment
P 771 Stess components
= > 15t
G P )M Section Moments
b 210 Spatil dplacement
» UR: Rotstional displacement
[
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Tha job Job-i" has besn created
|6 e Job mpue ¢ “ has ted tor analysiz
368 JobiPnat otas Sectesalutly
3% Je61 . dmag iy 'l
38 joby e |
The Fieid cutpe aded to tile *abaqus 7pt*

| | abaqus.rpt - Notepad ' @ﬂg

| File Edit Format View Help
l -
e e e R R e e R R R e R R R R R R R R R R R o R O O O O o O O o o o o o o o o o o o o o O O R R R R R O o o o o o o o o o o o o o o R R R R R R R R R R R R R
Field output Report, written Fri Dec 06 22:02:22 2013
source 1
ODB: C:/Users/GustavoN/Job-1.odb
Step: Carregamento
Frame: INncrement 1: Step Time = 1.000
Loc 1 : Nodal values from source 1 (3
output sorted by column "Node Label™.
Field output reported at nodes for part: ESCADACOMPLETA-1
Node U.Magnitude u.ul u.u2 u.u3
Label @Loc 1 @Loc 1 @lLoc 1 @BlLoc 1
M ni mum 0. -12.7826E-33 -18.301E-03 -881.644E-086
AT Node 205 201 55 316
Maximum 18.4996E-03 2.70387E-03 19.407E-33 881.644E-06
AT Node 55 55 g 235
Total 2.52123 294.604E-03 -2.50128 128.536E-09
e e e R R e e R R R e R R R R R R R R R R R o R O O O O o O O o o o o o o o o o o o o o O O R R R R R O o o o o o o o o o o o o o o R R R R R R R R R R R R R —

v" Na barra do menu principal, clique em File>Save As.... D& um nome ao
arquivo e cligue em OK (E possivel também salvar o arquivo com 0s
resultados ja calculados - job-1.0db).



